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Complete Train Control 
Run Your Trains, Not Your Track!

Features:	▪ Digitrax SoundFX®v3+ Sound System 
 128Mbit “Y”size Sound Memory allows all “high definition” SFX projects  
Your locomotives will sound “in scale” like the real thing with SoundFX v3+ 
Customizable with 16, 12 or 8 bit .wav file sounds 
Works with SoundFX 8 and 16 bit sound projects 
Up to 16 simultaneous voices/channels 
Download sounds with a Digitrax Sound Programmer and SoundLoader 
Supports 22Ks/s Audio 
Supports faster download speeds 
Cam input-synchronized steam-chuff exhaust option for steam locos 
Scalable Speed Stabilization configured for sound operation 
Dual “stereo” speaker outputs allow sound “image” position control 
SFX3+ allows selection of a specific sound project, if multiple are are loaded 

	▪ Two factory 8 Ohm 16 x 26 x 9 mm box speakers on 10-pin plug and 2-pin 
expansion, makes dual speaker  installation quick and easy.

	▪ Smart Power Management- no more booster or programmer shutdowns! 

	▪ Program CVs using any Digitrax Compatible Control system without having 
to buy any extra equipment.

	▪ Solder wires for track, motor and function control.

	▪ Series 7 XF Enhanced Decoder Features.

	▪ Digitrax FX7 Functions-Control lights and functions for prototypical lighting 
effects and on/off control.

	▪ Digitrax LocoMotion® System – Lets your trains run like the real thing!

	▪ 2 Digit and 4 Digit Addressing.

	▪ Basic, Advanced & UniVersal Consisting.

	▪ SuperSonic motor drive for silent operation.

	▪ Direct and Operations Mode programming.

	▪ Decoder Reset by CV8, with or without speed table reset.

	▪ Transponder Equipped ready for transponding ID on your layout.

	▪ Power-on Motor Isolation Protection, helps prevent damage to your decoder.

	▪ DCC Compatible.

	▪ FCC Part 15, Class B RFI compliant.

	▪ Operates on DCC track voltage 9V minimum. to 22V maximum.

SDYH588ST 	    SoundFX®v3+
Fits many Fits many HO and 
larger scale locomotives
8 CV60-Selectable factory Steam 
& Diesel Sound Projects [SPJs] Included

HO/S/O/G Scales
Mobile Decoder with SoundFX v3+
5 Amp/7 Amps Peak
8 FX7 Functions, 200ma Output
Two 8 Ohm 16 x 26 x 9mm Speakers  
330uF Capacitor
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Parts List:
1 SDYH588ST Function Decoder with SoundFX® v3+
1 Instruction Sheet
1 10-Pin Sound Harness - 8 Ω 16 x 26 x 9 mm box speaker and 330uF 		
         capacitor
1 2-pin expansion 8 Ω 16 x 26 x 9 mm box speaker 
 

Visit www.digitrax.com for the latest information on this product. 

Quick Start Installation Instructions:

Figure 1: SDYH588ST Decoder Components 
 

1.	 This decoder is suitable for HO or larger scale locomotives with a 
stall current at full DCC track voltage of up to 5 amps. 

2.	 Connect the red and black track leads to the locomotive track power 
connections. Connect the orange and gray motor leads to the isolat-
ed motor connections.  Motor connections must be isolated from the 
track feed or other voltages. 

3.	 Connect the function leads that are to be used for e.g. lights.  Insu-
late any unused wires so they cannot short to the locomotive frame 
or track power.  Figure 2 on page 11 details the wires and harness 
schematic and color codes. Be sure to use current setting resistors 
with LED lamps. Refer to locomotive documentation for any lamp 
requirements.

SDYH588ST: 11 wire 
Track, Motor and Func-
tion connections

2-Pin “rear” speaker Harness

10-Pin Sound Harness330uF capacitorFront speaker
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4.	 Mount the factory 8 ohm box 16 x 26 x 9mm speakers attached to the 
decoder in suitable locations.  Ensure the speaker diaphragms do not 
touch anything.  Other 8-ohm speaker(s) may be substituted.  Note: 
Depending on the locomotive model and construction, it may be 
necessary to modify the frame or parts of the internal shell to make 
room for the two speakers and enclosures. 

5.	 Do NOT connect anything but a speaker to the 2 pin speaker plug. 
Connecting an e.g. PX112 type power extender will cause non-war-
ranty damage.

6.	 Mount the 330uF electrolytic energy storage capacitor from the 10-
pin sound harness. Be sure not to short the capacitor case or leads to 
the track leads or locomotive frame.

7.	 For steam units using external synchronization cam capability, con-
nect the white CAM wire of the 10-pin sound harness to the output 
connection of your cam, and configure CV133 to a value of 128 to 
synchronize the steam chuff with this external cam input.

8.	 Inspect the installation before testing the sounds and replacing the 
shell.  In particular be sure that wires are correctly connected and 
routed and that no wires are shorted to the frame or track, or will be 
pinched at re-assembly.

9.	  NOTE: For sustained high-current operations, it is best practice to 
mount the flat heatsink face [opposite side from heavy track/motor 
wires] to a suitable surface to dissipate heat. This will provide the 
highest load capability before the decoder shuts down from over 
temperature . 

10.	 Place the loco on an active DCC track powered by a compatible DCC 
system and select the factory default address 03 and CV60=00 to 
ensure sounds for testing.

11.	 Be sure F8 (mute) is OFF to allow full sound output, and then press  
F1 (bell) or F2 (whistle/horn) ON to hear the associated sounds.

12.	 Customize sounds by programming sound CVs to adjust the desired 
configurations.  Sound Projects other than the factory loaded default 
can be overwritten by using a USB Digitrax SoundFX Programmer 
(DCS52, DCS210+, PR4 etc.) and using the free SoundLoader PC 
software from the Digitrax web site at https://www.digitrax.com/
sound-depot/. 
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Speaker Mounting and Enclosures:
The sound performance, volume and efficiency of speakers are greatly 
affected by the mounting system and required baffle or enclosure. The 
included 8 ohm box speakers are pre-mounted in baffles. Alternate 8 or 
4ohm speakers, baffles or other mounting systems may be used.  The 
decoder’s dual “stereo” speaker outputs allow sounds to be imaged to 
“appear” at different locations from front to rear of the model using 
newer stereo SPJ’s.  For best stereo dual channel image position effects, 
mount the two speakers as far apart as practical. Older projects config-
ure all sounds equally to image balance evenly between the speakers, for 
compatibility, and provide better sound than a single speaker.  

Digitrax SoundFX®v3+ System:
For a more prototypical railroading experience, your decoder can be  
customized for your specific locomotive by programming some of the 
Configuration Variables, or CVs, available. 
The CVs used in the range of CV140 to CV240 let you customize your de-
coder without needing to reload a new SPJ. Digitrax sound decoder CVs 
can be programmed using either a programming track or with the opera-
tions mode using the main line. See the Digitrax web site for information 
on programming decoder CVs. 

Customizing Your Decoder:
This decoder  will initially operate and generate sound using address 03. 
On a Digitrax system, simply select the decoder’s address and the sounds 
will start. [On some DCC systems, it is necessary to select the decoder 
address and send a command to start the sounds].  

Customizing Your Sounds:
CV60 selects the active SPJ. The SDYH588ST CV60  default of 00 is a 
GP38-2 diesel Compact Hi-Definition  factory SPJ.  Seven other pre-
loaded SPJ’s are selectable with CV60 values 10 to 70. If the locomotive 
you’re using is not close to one of the factory projects, you can erase the 
factory SPJ’s and download your new SPJ choice or sounds from the 
Digitrax, or other websites. 

The CV60 control of the SDYH588ST differs from previous SFX decod-
ers: The high decimal digit selects a sound project#, from 0 to 7, and 
the lower digit will select scheme 0 to 9 within that sound project (if 
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implemented, default 0). You can view the expanded intents and capabil-
ity of any .spj sound project file in SoundLoader, with view>view project 
description  command.
Sound Control Functions: The following function key table shows 
how each controls sounds for a factory SPJ.

Function# Function Controls Notes

F0 Lights/Steam-Dynamo F0 controls directional white/yellow wires
F1 Bell CV146 controls rate, CV157 selects bell type
F2 Horn/Whistle CV150 selects horn choices
F3 Coupler crash Auto coupler/brake set by CV151 max speed

F4 Air feature disable
Steam- Blowdown

F4 OFF enables pop-off,
drier and starts compressor/air pump

F5 Diesel - Dynamic Fans
Steam- Open cylinder cocks Cylinder cocks off when stopped.

F6 Diesel - Notch Up
Steam - bump up chuffs

Notch UP if CV155=01 or
02

F7 Diesel - Notch DOWN
Steam - bump down chuffs

Notch DOWN, if CV155 = 01 or 02

F8 Mute Control F8 ON is muted at volume in CV135

F9 Uncoupler

F10 Brake to stop Stops motor, resume speed F10 off
F11 Hand Brake set When stopped
F12 Emergency Stop Sounds resume after F12 released

Configuration CV setup:  The following tables show the CVs used in 
this decoder sound project and how it is set up at the factory to operate 
various sounds using your throttle.  SFXv3 CV assignments are generally 
consistent with earlier Digitrax decoders.  

Motor Drive Frequency: CV9: CV9 value sets motor frequency in 
KHz, range 4 to 50KHz for CV values 01-50.  00 sets a supersonic 16KHz 
default.

Motor Back EMF (BEMF) Trim: CV10: Value 64 and up to 127 
slows down step1 BEMF motor speed. 00 default also sets this to 64.  

Motor Control: CV55/CV56/CV57: CV55 sets BEMF static gain, 
CV56 controls dynamic gain, CV57 sets BEMF Intensity.  This is same as 
prior Digitrax decoders.  

Master Volume: CV58: The value in CV58 sets the master sound 
volume, and CV140 to CV145 trim volumes for specific sound types.  If 
you download a new .wav sound file for any of the sounds in the schemes, 
be careful to set a volume level that does not overdrive the speakers, 
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which may cause distortion or damage.

 
CV# Sound Control Usage Range Default 

Value

01 2 Digit Address 1-127 03

11
Sound Time Out, 06 = Sound ends when loco address is 
unselected, 00=Sound stays on after loco is unselected

06

29
Configuration Register - Speed steps, 2 /4 digit address-
ing, Analog Mode, Normal direction of travel, speed 
tables

06

49 FX effect: Forward Light (FOF) - Headlight 00

50 FX effect: Reverse Light (FOR) - Reverse Light 00

51 FX effect: Function 1 lead 00

52 FX effect: Function 2 lead 00

58 Master Volume (F8 used for Mute) 1=min 00=max 00-15 08

60 Sound Scheme Select 00-70 00

132 Notch Rate 00-255 127

133
Steam CAM config, 128=>EXT cam, 1-127=>DRIVER 
dia”

01-128 63

134 Steam Gear Ratio Trim, 32 = 100% Ratio 00-255 32

135 Mute Volume 00-64 00

140 Prime Mover / Chuff Volume 00-64 60

141 Bell Volume 00-64 25

142 Horn/Whistle Volume 00-64 60

143 Time-Scattered Air Effects Volume 00-64 30

145 Miscellaneous Volumes 00-64 40

146 Bell Ring Rate (1= 24 milliseconds delay) 01-100 07

147 Air Drier Rate (1= about 2 seconds delay) 01-64 02

148 Compressor/Air pump Run Rate (seconds delay) 00-255 25

149 Air Compressor On Time 00-255 36

150
Horn/Whistle Setup (Default=0, Playable Horn=1, Alter-
nate Horn=2 +128 for playable volume.)

00-07 or 
128-135

00

151
Auto Coupler Sequence Threshold Value-Peak speed for  
coupler/brake when direction change occurs and F3 is 
ON

00-64 28

152 Project Author ID, 222, =Digitrax Compact HiDef SPJ 222

153 Project ID [= Hi decimal digit of CV60 value] 0-7 0

154 Steam Blow down / Safety Volume 0-64 20

155 Notching/Slip Mode: 00=Automatic, 00

157 Bell Selector 00-03 00
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Selecting a Sound Project on Your SDYH588ST:  CV60   
The SDYH588ST comes with 8 different  single-scheme SPJ’s loaded in 
sound flash , 6 diesel and 2 Steam.  The active SPJ is selected by the value 
in CV60 [in steps  of 10], as shown in following table.  Low digit always 0.
 
CV60 decimal 
value

Factory SPJ

00 GP38-2 diesel
10 AC4400CW diesel
20 GP7 diesel
30 SD70MAC diesel
40 SD40-2 diesel
50 C420 diesel
60 ATSF 3751 Heavy Mountain Steam 

70 UP3985 4-6-6-4 Challenger Steam

Selecting Horns/Whistles/Bells: CV150, CV157:  CV150 can 
select between available horns, and CV157 choses between available 
bells.  To allow using Compact Hi-Definition SPJ’s in older “X”/16Mbit 
SFX decoders, the horn/bell choices are fewer, but you can use Sound-
Loader to download the exact Horns or bells you choose.  To enable play-
able volume for your selected horn or whistle add +128 to the selected 
value (i.e. Playable volume on horn 00 is enabled with a value of 128, i.e. 
00+128=128). 

Notching: CV132 and 155:
CV155 is provided to select Diesel engine “notching” modes, or Steam 
project slip. The default of CV155= 00 provides “automatic notching” that 
changes the diesel RPM/Chuff settings at 8 distinct throttle speeds that 
are configured by Sound CV132 and follow speed% directly. 
Sound CV155=01 selects “semi-automatic notching” mode that allows F6 
ON to increase the notch up from the current throttle setting and F7 ON 
to decrease back down towards the lowest current throttle notch setting. 
Sound CV155=02 selects “manual notching” mode that allows F6 ON to 
increase the notch setting and F7 ON to decrease the notch sound setting, 
irrespective of the throttle speed, which then controls just the motor 
speed. For Steam, a F6 notch-up while stopped will generate chuffs as 
if wheel slip is occurring.  A F7-notch down will return to stopped/no 
chuffs.
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Steam Exhaust Chuff / Cam Configuration and Gear Ratio 
Trim: CV133 and 134:
CV133 controls the Steam Chuff / Cam configuration in the decoder. It 
allows you to set the value of the CV equal to the diameter of the driver in 
inches from 1-127.  Set CV133 to 128 to enable the external cam lead con-
trolling steam exhaust chuffs.  CV134 controls the gear ratio trim, where 
a value of 32 equals a 100% ratio.

Bell and Air Effect Rates: CV146-149:
CV146 controls the bell rate or time between rings of the bell, it has a 
range from 1-100 with each increment adding 24ms of delay.  CV147 con-
trols the drier rate, it has a rage from 1-64 with each increment adding 
about 2 seconds.  CV148 controls the Compressor/ Air pump start rate 
and CV149 controls how long the Compressor/ Air Pump runs.

Auto Coupler Sequence Threshold Value: CV151:
CV151 controls the threshold at which coupler and brake sounds are
automatically played when the locomotive direction changes and func-
tion 3 is enabled. CV151 has a range of 0-60.

Loading Other SPJ’s in your SDYH588ST:
SDYH588ST decoders can run new Compact Hi-Definition SPJ’s  with 
up to 16 channels, and up to 128Mbit of SPJ downloads.
The 16 channels allow steam sound schemes to overlap near and far-side 
steam sounds, and articulated engines for more realistic steam exhaust 
sound. The 128Mbit sound flash is big enough to use “high definition” 
sound projects and more complex schemes with fully expanded and lon-
ger diesel notch run and transition sound files.
Decoder sounds can be re-loaded or customized using a Digitrax SFX 
programmer and your computer with the SoundLoader software.  Both 
the software and a number of alternate Sound Project files are available 
from the Digitrax Sound Depot, if you have erased the factory SPJ’s. 

Log onto and join the free web site https://groups.io/g/AnPRR/files as 
an  excellent source of over 300 free SPJ’s, including larger “high defi-
nition” projects that can make use of 128Mbit sound capacity. It takes 
about 5 minutes to download the biggest SPJ to your decoder, and you 
can customize any of the wave files before downloading.
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SoundFXv3+ DC Operation Mode:
1.	 Digitrax SoundFX v3+ decoders will operate on smooth DC power if 

CV29 is 06, allowing Analog Mode conversion.
2.	 Sound/motor will not start until about 6VDC on the track.
3.	 It is not practical to Consist/MU decoder equipped locomotives with 

non-decoder equipped locomotives, since they will not operate at 
same speed on shared track DC power.

SDYH588ST Troubleshooting:

If sound does not start in the decoder when on powered track:
1.	 Make sure you have selected the locomotive address on a throttle. 

The sound will not startup and run unless the locomotive is ad-
dressed by the system.

2.	 Check your installation to make sure the decoder is installed  
properly. 

If the sound output seems distorted:
1.	 Check the speaker cone for magnetic debris that may have collected 

there. Debris on the speaker must be removed and this, or damage 
will cause a loss of sound quality.

2.	 Be sure that the CV58 volume is not set at a level that sets sound 
power too high for the track power and speaker being used.  

If motor does not run:
1.	 Check the motor is properly connected.
2.	 Make sure locomotive address is correct and selected. Activate F0/

lights to see if decoder is powered and addressed properly.
3.	 If Front and Rear lights come uncontrollably solid ON and wink off 

once every 4 secs, the motor is not properly isolated from stray volt-
ages.  Check wiring. 

If the sound in your decoder shuts down after you stop it and 
you are not using a Digitrax system for control:   
On some DCC systems decoders are not addressed by DCC packets after 
the locomotive is set to 0 speed. 
In this case after the CV11 timeout elapses (6 second default), sound will 
“shutdown.”. To defeat this feature, set CV11=00 to remove the timeout 
and shutdown. To make sounds, the decoder must have a command 
addressed to it at least once. 
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If you have trouble reading back CVs on the programming 
track:  This may be due to insufficient current draw for program ac-
knowledgment.  You can always just re-program or write the CV value 
into a CV to get the desired results, even if reading CVs does not work. 

OPS/Mainline mode is recommended for writing to (programming) all 
CVs except CV01, CV17 & CV18 (2 digit and 4 digit addresses). 
If a second DCC decoder is present that is not SoundFX compatible then 
correct read back of CV data is not possible, since CV read back was not 
originally designed for multiple decoder read back.  
 
The SDYH588ST plays a Steam scheme, but I want the de-
fault Diesel scheme:   If the factory sound project with the 8 projects 
has not been erased, program CV60 back to a value of 00 to reselect the 
default GP38-2 diesel project. The SDYH588ST SPJ’s are on the web 
site so you can reload if you get lost.  Program CV8 to 8 to restore factory 
settings and any customized CV’s defined in the SPJ. 

I have loaded a new sound project but, the CVs and Function 
controls are not what I expected:   In SoundLoader, open the sound 
project .spj file you programmed with “File>Open Sound Project File”.  
Now select “View>View Project Description”, the Project description 
usually defines how the project operates and how CVs and functions are 
configured for sound generation.

I have loaded new .wav files for a bell in 16 bit resolution vs the 
12 bit, but don’t hear much difference. Why?  With most small 
speaker systems it is tough to hear difference between a 12 and 16 bit 
download, or even an 8 and 16 bit download.  This is particularly true 
if there is any noise in the layout room.  In most cases the extra cost for 
“CD quality sound” is not justified.  With a number of sound locomotives 
running at same time it gets quite  noisy, and so many operators simply 
turn down the decoder volumes anyway.

I want to load new .wav files with 12 bit resolution instead of 
8 bit, but do not have room in the sound flash memory.  Save 
your project (.spj ) to a new named project: “ File> Save Sound Project 
File As” saves the project file with a new name. Next, right click on any 
.wav file you do not need or use, and select “Remove Association”.  This 
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will skip this .wav when pressing the green download “ALL”, or  “Pro-
gram Wavs” button, and the SFX decoder will not output this, or skip this 
sound as silence.  This frees up sound flash memory for you to download 
12 or 16 bit .wav files that you prefer, and be within the memory size 
available.
You can skip all .wav files that are not needed for the scheme you want to 
run, and/or can substitute any .wav versions you may prefer.  Remem-
ber to save any modified project version with “File> Save Sound Project 
File”. 
 With free memory, you can download any single .wav by selecting,  then 
right clicking on the .wav entry and selecting “Download this Sound”.

Figure 2: SDYH588ST: connection diagram
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Made in the USA

2443 Transmitter Road 
Panama City, FL 32404
www.digitrax.com
Need Support? 
helpdesk.digitrax.com

If you have insufficient sound flash memory to load new files, the whole 
flash memory and all sound project(s) will be erased before you load a 
new SPJ. 

You may change the factory box speakers to ones you prefer of different 
sizes for a better fit. We recommend you cut an existing speaker lead at 
about the mid point and solder on your new wires there, away from the 
plugs.  Insulate these joints with e.g. small heat shrink covers.  Keep the 
wire color polarity so the new speakers have correct phasing so as to not 
cancel sounds.
Best practice is to test a new decoder on the bench to confirm functional-
ity and get acquainted with setups and sound choices.
 

Warranty & Repair
Digitrax gives a one year Warranty against manufacturing defects for 
this product. Visit www.digitrax.com for instructions for tech support 
and returning items for repair.  
 
Please return warranty items directly to Digitrax - DO NOT re-
turn items to place of purchase.  
errors and omissions excepted.
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